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Dear Valued Customer:

It's time to "March ahead" and continue learning about the
Internet with a little help from our eNewsletter. It starts with
a warning about a fake Microsoft Outlook update that's
currently circulating via e-mail, including a review of the
dead giveaways that identify it as a scam. Next, you'll find
out about the mechanics (and etiquette) of declining a
Facebook friend request, as well as how to remove those
annoying colored lines from a forwarded e-mail before
sending it to others. Be sure to check out the Great Sites for
a championship resource, a keyboarding training ground, an
out-of-this-world opportunity, and a healthy variety of
recipes.

The goal of each of our monthly eNewsletters is to keep our
subscribers informed regarding their Internet connection and
to improve their Internet experience. We think you'll find
this information interesting. If, however, you'd prefer not to
receive these bulletins on a monthly basis, please see the
links at the bottom of this e-mail to manage your
preferences.

To see what's inside this issue, simply scroll down the
eNewsletter or click on the links within the index to the left.
Thanks for reading!

E-Mail Virus - Watch for Fake Microsoft Outlook Update

A spam attack is now circulating e-mails that appear to be sent from Microsoft Support,
advising users of a new security update for Outlook/Outlook Express. Recipients are told that
this is a critical update for stability and security, and are given instructions for opening the
attached zip file to complete the installation. In actuality, the only thing that would get
installed in this process is the malicious Bredolab.Y virus and a rogue antivirus program called
SecurityTool—both of which could cause serious problems with your computer.



& Update lor Microsoll Dutlook / Dutlook Bxpress (EB910721)

From: Microsaft Support
Date: .

Toe

Subyject: pdiste For Microsalt Cutook | Cutiook Express (KBI10721)
Attach: ’dﬁmmﬂ?lﬂ?‘zl-ﬁﬁw.ﬂ: (9,36 KB)

=
Enef Desenphon
Microsoft has released an update for Microsoft Outlook ¢ Outlook Express. This update is cntical and prowndes you
with the latest version of the Microsoft Outlook / Outlook Express and offers the highest levels of stabidity and

secunty.

Instructions

* Install Update for Microsoft Outloak / Outlook Express (FEB910721). To do this, follow these steps
1. Bun attached file officexp-EB310721-FullFie-ENT exe

2, Restart Microsoft Cutlook / Cutlook Express

System Requirements

* Supported Operatng Systems: Windows 2000, Windows 98, Wndows ME; Windows NT, Windows Server
2003, Windows XF, Windows Vista

* Thas update apphes to the followang product: Microsoft Cutlook f Cutlook Express

=
I |

If you receive an e-mail like this that claims to come from Microsoft, delete it and do not open
the attachment. Keep in mind that Microsoft NEVER sends patches or security updates as e-
mail attachments. Any e-mail asking you to install such items should be considered a dead
giveaway of fraud.

In addition, Microsoft advises the following precautions:

Keep your firewall turned on.

Keep all your software and your operating system up-to-date.
Keep your antivirus software up-to-date.

Keep your antispyware technology up-to-date.

To learn more about how to get authentic Microsoft security updates, visit:
http://www.microsoft.com/security/updates/bulletins/201001-00b.aspx
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Springtime Special: 1 FREE MONTH Of Internet Service*

o
Refer a friend to sign up for Internet service from RUC by
April 30, 2010 and you'll both get one FREE month.*
Are you a current Internet customer of RUC? Do you know V8
people who don't have our Internet service but could =5
benefit from it? Now's the time to refer a friend who is not a *,- -

current Internet customer to sign up with us. When your
friend becomes our customer, you'll both get one month of ’ .
FREE Internet service.* ‘




RUC offers a variety of benefits including:

High speed Internet options to meet anyone's requirements

Convenient Help Desk hours for support when you need it

Spam and virus filtering to save you time and protect your computer

Free monthly eNewsletter that includes updates on recent e-mail viruses and hoaxes

Simply fill out a referral card (click here) or give us a call at 608-768-1000. Or when your
friend signs up for Internet as a new customer, simply have him/her list your name and e-mail
address as the referral.

**Referral Program: Offer ends 04/30/10. Accounts are limited to 12 referrals/yr. Subscribers must have active
service for 30 days before making a referral. Customer cannot refer themselves. Referred/referring customers
must maintain an active account for 30 consecutive days to receive one free month of Internet. RUC employees
are not eligible. RUC reserves the right to modify, extend or cancel offers at any time. Offer good for residential
customers only. The free month of Internet service is applied to the accounts after your friend has been in active
service for 30 days. Both accounts must be in good standing, and other restrictions may apply. Contact us for
complete details.
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New Programming - On The Local Channels

Mayoral Forum playback to be aired March 19th on Reedsburg channel 12! Check our website
for more details on official playback times closer to the 19th.

"Mission It's Possible" to air on Local Channel 11 beginning March 12th, check our website for
more details.

RAMC, in partnership with Reedsburg Utility's Channel 11, will debut "The Joy of Healthy
Cooking" with Registered Dietitian Judy Martin. The Joy of Healthy Cooking will air monthly -
Tuesdays, Thursdays and Sundays at 9am, 2:30pm and 6:30pm on Reedsburg Utility
Commission Channel 11. In the near future, The Joy of Healthy Cooking will also be an e-
cooking show, running on the Medical Center's website, www.ramchealth.com. Each month,
Judy will present a new topic. March is featuring the ease of preparing a healthy

breakfast. April will feature Power Eating, in preparation for the upcoming Vet Fest half
marathon, 5K and 1 mile or any exercise activity.

Each month, recipes will be posted online at www.ramchealth.com and
www.reedsburgutility.com. Every recipe will include nutritional information. One of the three
featured recipes is highlighted below. Viewers will also have the opportunity to ask a question,
which Judy will try to answer at the end of each month's show. Diet and nutrition-related
questions can be emailed to healthycooking@ramchealth.org.

Tune in to Reedsburg Utility's Channel 11 to watch The Joy of Healthy Cooking with Judy
Martin!

Baked Oatmeal

3 cups dry oats (can use quick or old fashioned)
Half cup packed brown sugar

2 teaspoons baking powder

Half teaspoon salt (can omit for lower sodium)
2 eggs

1 and a half cups low fat milk

Half cup canola oil



1 teaspoon vanilla extract

For peach and blueberry: Drain one, 150z. can dried peaches and one cup fresh or frozen
blueberries. Can use any other fruit you like.

1/3 cup chopped walnuts

Method: In a large bowl, combine the oats, brown sugar, baking powder and salt. In a small
bowl, whisk the eggs, milk, oil and vanilla. Stir into dry ingredients and let stand 5 minutes.
Fold in the fruit gently. Transfer to an 11 x 7" baking dish which has been coated with cooking
spray. Sprinkle top with walnuts. Bake, uncovered, in a 350 degree F. oven for 35 — 40
minutes or until top is browned lightly and center springs back when touched. Makes 9
servings. Per serving: 277 calories, 11 gm fat, 263 mg. sodium, 38 gm carbs, 3 gm fiber and
8 gm protein. Recipe adapted from Taste of Home.
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Sites Of The Month - Great Sites To Check Out In March

Trouble Typing?

http://keybr.com - Is your hunt-and-peck typing method amusing to your friends? Typing (or
keyboarding) is an important skill, and this site helps you improve your speed and accuracy. It
will give you sample text or you can import Web content to practice on. With each session,
you'll see your words-per-minute rate and number of mistakes. You can also view a chart
showing your progress and see the letters that cause you the most trouble.

Cooking Outside the Box

http://backofthebox.com - This site contains thousands of recipes literally taken from the back
of food product boxes. You can search for recipes under food type, reader favorites, or "quick

and easy."” You can also check out the helpful cooking hints. If you'd like, let the recipes come
to you by subscribing to the Recipe of the Day or the weekly newsletter.

Healthy Eating With the Biggest Loser

http://nbc.com/the-biggest-loser - March is National Nutrition Month, and you can celebrate by
finding out more about healthy eating. One way to do so is to visit the Biggest Loser site,
where you can join the Biggest Loser Club. Club members gain access to ideas for better food
choices for weight loss and health, as well as recipes, meal ideas, exercise demonstrations,
interactive assessments, ways to handle everyday food challenges, and other resources.

"Four" Events and More

http://ncaa.com - Visit this site to get all your college sports information in one place,
including scores, statistics, rankings, and videos. Check on tickets and get details on the three
big championship events coming up in April: the Final Four in Indianapolis, the Women's Final
Four in San Antonio, and the Frozen Four in Detroit. Still want more? Visit the site's shop to
find clothes and accessories from your favorite teams.

Be Part of the Next Mars Mission

http://mars.jpl.nasa.gov/msl/participate - In the fall of 2011, NASA's Jet Propulsion Laboratory
will launch the Mars Science Laboratory rover to help determine the "habitability” of the red
planet. On this site, the Laboratory invites the world to participate in the mission by following
its progress on Twitter, submitting your name to be included on a microchip on the rover,
becoming a virtual citizen of Mars, or competing in the Pathfinder Innovation Challenge.
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Short Tutorial - Preventing Colored Lines in Forwarded E-mails



When a rich text e-mail has been forwarded many times, it can be full of vertical colored lines
on the left side. These items detract from the e-mail's appearance and can be annoying to
recipients of the message. Follow the steps below to adjust your settings to prevent colored
lines from appearing in your forwarded e-mails. You'll also find notes on how to "clean up" an
e-mail from someone else before you send it on to other people.

Preventing Colored Lines In Forwarded E-mails Using ...
E-Mail Program: Outlook Express
Computer Operating System: Windows XP

1. With Outlook Express open, click your cursor arrow on the "Tools" menu and select
"Options..." from the resulting drop-down menu.

2. When the Options window opens, click on the "Send" tab.
3. Within the "Mail Sending Format" section, click on the "HTML Settings..." button.

4. When the HTML Settings window opens, uncheck the box next to "Indent message on
reply.” Click "OK" to return to the Options window.

5. Click on the "Apply" button and then the "OK" button to close the Options window.

NOTE: If you receive an e-mail that already has colored lines from being previously forwarded
and you want to eliminate them before forwarding it, address the message as normal. Then
select all of the text in the message by clicking in the body of the message and pressing the
Ctrl and "A" keys on your keyboard. The contents of the message will be highlighted. Click on
the "Format™ menu and drop down to "Decrease Indent.” Repeat as needed.

Preventing Colored Lines In Forwarded E-mails Using ...
E-Mail Program: Windows Mail
Computer Operating System: Windows Vista

1. With Windows Mail open, click your cursor arrow on the "Tools" menu and select
"Options..." from the resulting drop-down menu.

2. When the Options window opens, click on the "Send" tab.
3. Within the "Mail Sending Format" section, click on the "HTML Settings..." button.

4. When the HTML Settings window opens, uncheck the box next to "Indent message on
reply.” Click "OK" to return to the Options window.

5. Click on the "Apply" button and then the "OK" button to close the Options window.

NOTE: If you receive an e-mail that already has colored lines from being previously forwarded
and you want to eliminate them before forwarding it, address the message as normal. Then
select all of the text in the message by clicking in the body of the message and pressing the
Ctrl and "A" keys on your keyboard. The contents of the message will be highlighted. Click on
the "Format” menu and drop down to "Decrease Indent." Repeat as needed.

Preventing Colored Lines In Forwarded E-mails Using ...
E-Mail Program: Mail.app
Computer Operating System: Mac OS X 10.5



1. With Mail.app open, click your cursor arrow on the "Mail" menu and select
"Preferences” from the resulting drop-down menu.

2. When the Preferences window opens, select the "Composing" tab by clicking on its
icon.

3. Under "Responding," uncheck the box next to "Increase the quote level."

4. Close the Preferences window by clicking the red dot in the upper left corner.

NOTE: If you receive a message that already has the colored lines from being previously
forwarded and you want to eliminate them before forwarding it, address the message as
normal. Then select all of the text in the message by clicking in the body of the message and
pressing the Command and "A" keys on your keyboard. The contents of the message will be
highlighted. Click on the "Format" menu and drop down to "Quote Level" and then "Decrease"
from the submenu. Repeat as needed.
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This Month's FAQ - What's The Polite Way To Decline A Facebook Friend Request?

Question: People | knew (and didn't particularly like) in high school have been contacting me
about being a friend on Facebook. What's the polite way to decline a Facebook friend request?

Answer: The mechanics of this are pretty simple. You have
two options for responding to a Facebook friend request. You
can either click on Ignore or Confirm. When you click on
Ignore, the friend request is removed from your inbox and
the requester receives nothing. When you click on Confirm,
the requester receives a notification of your decision.

facebook

So, if that former classmate is paying attention and notes that a friend notification regarding
you never shows up, he or she can figure out what happened. However, you probably don't
need to be too concerned about hurt feelings. Chances are good that this person was sending
friend requests to everyone they ever knew, and in a few days, won't even remember sending
one to you.

Everyone uses Facebook differently. Some people want to collect as many friends as possible,

and others want to limit their Facebook interaction only to close friends and family. Do what
feels comfortable for you.
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We hope you found this newsletter to be informative. It's our way of keeping you posted on
the happenings here. If, however, you'd prefer not to receive these bulletins on a monthly
basis, please see the links at the bottom of this e-mail to manage your preferences.
Thanks for your business!

Best regards,

Catherine Rice



Director of Marketing

501 Utility Court
Reedsburg, WI 53959

608-768-1000

(We have used our best efforts in collecting and preparing the information published herein.
However, we do not assume, and hereby disclaim, any and all liability for any loss or damage
caused by errors or omissions, whether such errors or omissions resulted from negligence, accident,
or other causes.)



